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1 General Informations
ArtFun+ is a class I medical device manufactured by IMAGEENS.
Below are the different informations related to the manufacturer of this device:
Manufacturer Legal Adress

42 Rue de Maubeuge 75009 Paris

Company’s main office

23 Avenue d'Italie 75013 Paris

E-mail address

hello@imageens.com

Internet Website

https://www.imageens.com/

1.1 Intended Use
ArtFun+ is intended to be used for viewing, post-processing, and quantitatively evaluating Magnetic
Resonance Images (MRIs) of the following type: aortic cine 2D+t (sequence of 2D images over time)
Steady-State Free Precession (SSFP), aortic cine 2D+t Phase Contrast (PC) and thoracic 3D SSFP in a
DICOM standard format.
It allows the calculation of MRI Distensibility and aortic arch MRI Pulse Wave Velocity.
This information could be used by medical imaging healthcare professionals, in conjunction with the
patient’s clinical history/symptoms/other diagnostic tests/physician’s professional judgment, in the
context of cardiovascular health surveillance, for the assessment of the general cardiovascular risk of
the patient.
It is given as general information and shall not be used for diagnosis or treatment activities.
The device is intended to be use by Medical imaging professionals trained in examining & evaluating
Cardiac MRI for general patient population between 45 and 84 years old.

1.2 Contrindication, precautions and warnings
No contraindications have been identified for ArtFun+.
Used MRI images must be compliant with DICOM standard and DICOM fields must not have been
modified other than for anonymising patient-related information.
The exported results database files must be closed and not used by any other applications during the
use of ArtFun+ to prevent corrupting the database.
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2 Technical Requirement
In order to guarantee the proper functioning of the device, it is necessary to ensure that the computer
operating ArtFun+ meets the criteria listed below:
Criteria

Requirement
Dual Core Intel i5 ou supérieur, d’architecture 7th-gen/Kaby Lake or
higher

Computer Processor

OR
Apple M1

Computer Memory

8 Go de RAM of higher

Computer OS

MacOS BigSur (v11.0 à v11.5)

Application previously
installed

Osirix v11 or higher OR Horos v3.3 or higher

An internet connection of 100 Mb or more is also required when first activating the product license and
at each start for license validation.

3 Getting started with ArtFun+
3.1 Installation
ArtFun+ software was designed as a plugin for Osirix and Horos.
Ensure the previously mentionned version of Horos OR Osirix is installed.
Unzip and launch the installer file by double click.
Osirix / Horos will start and ask you if want to install the plugin. You might be asked for your system
password by macOS to allow the installation.
Osirix or Horos will ask you to restart to complete the installation.
After a restart of Osirix/Horos, you will find the plugin in the menu “Plugins” ► “Image Filters”.
In the Osirix/Horos 2D Viewer panel, go in the menu “Format” ► “Customize Toolbar and drag&drop
ArtFun+ into the usual toolbar to create a shortcut to ArtFun+,
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☹ If the plugin is still missing, it may have been wrongly installed. You can check if Horos/Osirix find it in
the “Plugins” ► “Plugins Manager” ► “Installed Plugins” tab.
☹ For the uninstallation, open the "Plugin Manager" of Osirix or Horos (Plugins ► Plugin Manager).
Select the plugin and uninstall it with the "Uninstall selected plugin" button.

3.2 Start the plugin : Get a license key
1. Start the plugin via the plugin menu item (Plugins ► Image Filters ► ArtFun+), from the 2D
Osirix/Horos Viewer panel, or from your own shortcut on the toolbar.
o If your computer is a Mac with an M1 processor and you don’t have the Rosetta library
installed, you will be prompted to install this library. This action is required for M1 Mac
to be able to run ArtFun+.
o If it is the first time you launch the plug-in you might be prompted, through a pop-up, to
allow the plug-in to access your data.
2. The application prompt for the license key to activate the plugin
3. If you don’t have one, you can request it by filling your email address in the first field and
sending it through the “Request activation” button. We will receive your demand, and contact
you by email for the license key.
4. Once you have your license key, paste it in the second field and unlock the plugin through the
“Activate license” button
5. The plugin is unlocked: you may have to click on it again in Osirix/Horos to get your first image.
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4 ArtFun+ Layout
Once the plugin is activated and you launch it from Osirix/Horos Toolbar, you will be directed to the
ArtFun+ User Interface (UI).

(1) Viewer: images are displayed here
(2) Metadata panel: Find patient and study information
(3) Viewer controls: Basic navigation tools
(4) Time frame / anatomical position slider: Select which time point or anatomical position to display in
viewer
(5) Workflow controls: tools used for the analysis process
(6) Results panel: ROI labeling, graph charts and clinical indices
In both (2) and (6) panels you can navigate in several sub panels by clicking on the different icon on the
top

4.1 Viewer
The Viewer display different images from a specific 2D+t or 3D series and provide the following
information:
Image size

The size in pixels of the current image (columns / rows)

Trigger time

The trigger time (in ms) of the current image and the total sequence time
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Image index

The index of the current image and the total number of image

Pixel size

The physical size comprised in a pixel (vertically / horizontally)

Slice thickness

The physical size imaged by the current image

Slice location

The physical relative position of the current image in the sequence

TE

The echo time used in the acquisition of the current image

TR

The repetition time used in the acquisition of the current image

CL & CW

The current color level and window (luminosity and contrast)

4.2 Metadata Panel
The Metadata panel shows information of the series that is currently loaded. There are 2 subpanels that
show patient metadata by clicking on the icon (a) and study and series identifiers by clicking on the icon
(b) .
You can expand or diminish the Metadata panel by clicking on the left panel icon (c).

(b)

(a)

a)

(c)

Patient metadata:

The following patient information is listed:
Name

Patient’s name as provided by the PatientsName (0010,0010) DICOM field

ID

Patient’s ID as provided by the PatientID (0010,0020) DICOM field

Birth Date

Patient’s birth date as provided by the PatientsBirthDate (0010,0030) DICOM
field
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Sex

Patient’s sex as provided by the PatientsSex (0010,0040) DICOM field

Age

Patient’s age as provided by the PatientsAge (0010,1010) DICOM field, in
years (y)

Weight

Patient’s weight as provided by the PatientsWeight (0010,1030) DICOM field,
in kilograms (kg)

Height

Patient’s height as provided by the PatientsSize (0010,1020) DICOM field, in
meters (m)

Heart Rate

Patient’s heart rate as provided by the HeartRate (0018,1088) DICOM field, in
beats per minute (bpm)

BMI

Patient’s body mass index as provided by the PatientsBodyMassIndex
(0010,1022) DICOM field, in kilograms per square meters (kg/m2)

Body Surface Area

Patient’s body surface area, in square meters (m2)

Carotid SP

Patient’s systolic blood pressure measured at the carotid, in millimeter of
mercury (mmHg)

Carotid DP

Patient’s diastolic blood pressure measured at the carotid, in millimeter of
mercury (mmHg)

Carotid PP

Patient’s pulse blood pressure calculated as Carotid SP – Carotid DP, in
millimeter of mercury (mmHg)

Brachial SP

Patient’s systolic blood pressure measured at the brachial artery, in millimeter
of mercury (mmHg)

Brachial DP

Patient’s diastolic blood pressure measured at the brachial artery, in
millimeter of mercury (mmHg)

Brachial PP

Patient’s pulse blood pressure calculated as Brachial SP – Brachial DP, in
millimeter of mercury (mmHg)

Central SP

Patient’s systolic blood pressure measured at the aorta, in millimeter of
mercury (mmHg)
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Central DP

Patient’s diastolic blood pressure measured at the aorta, in millimeter
ofmercury (mmHg)

Central PP

Patient’s pulse blood pressure calculated as Central SP – Central DP, in
millimeter of mercury (mmHg)

Aortic Distance for
MRI PWV

Aortic distance between the ascending and descending aorta section for PWV
estimation (mm)

Tonometric PWV

Patient’s pulse wave velocity measured by tonometry, in meter per second
(m/s)

HDL cholesterol

Patient’s high density cholesterol level, in millimole per liter (mmol/L)

LDL cholesterol

Patient’s low density cholesterol level, in millimole per liter (mmol/L)

Total cholesterol

Patient’s total cholesterol level, in millimole per liter (mmol/L)

Framingham score

Patient’s Framingham risk score, in percent (%)

Smoker

Indicate if the patient is a smoker

Diabetes

Indicate if the patient has diabetes

High blood pressure

Indicate if the patient has hypertension

Angina

Indicate if the patient has angina

Medical history

Indicate relevant information about the patient’s health

If the related information is available from the DICOM metadata of the loaded series, fields will be
automatically filed. If not, fields are empty by default.
☺ Most of the patient fields are editable by the user that wants to add relevant information for
reporting.

Page 10 sur 28

REC_IFU_20210728_2 - ArtFun+ IFU

b)

Study and series identifiers:

Le nom de l'étude et les noms des séries qui sont actuellement chargés sont affichés.

4.3 Viewers controls
The icons right above the viewer are basic navigation tools to control the display of images.
Icon

Name

Description

Shortcuts

Default tool

Return to default behavior
and cancel any pending
action.

Left click + drag onto viewer to move the
image. Mouse wheel up/down to zoom in/out.
Shift + left click + drag up/down onto viewer to
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adjust contrast, and left/right to adjust
luminosity

Panning tool

Move the field of view

Left click + drag onto viewer to move the image

Zoom tool

Change the zoom level

Left click + drag up/down onto viewer to zoom
out/in

Luminositycontrast tool

Change the luminosity and
contrast

Left click + drag up/down onto viewer to adjust
contrast, and left/right to adjust luminosity

Reset tool

Reset the view point to
initial position

None

4.4 Time frame / anatomical position slider
Le curseur de position temporelle / position anatomique est la barre inférieure située juste en dessous
de la visionneuse qui affiche et contrôle le point temporel ou la position anatomique sélectionné(e)
(selon le type d'image chargé, respectivement 2D+t ou 3D).
Vous pouvez visionner la séquence image par image en utilisant les boutons "backward"/"forward" ou
en cliquant directement sur un point. La séquence peut également être animée dynamiquement en
mode cinéma à l'aide des boutons "play"/"stop".

4.5 Workflow controls
The workflow controls are used in the arterial analysis: segmentation, post-processing and reporting
functions. The tools shown here are context sensitive such that they will be enabled or disabled
depending on which type of MRI sequence is active. Below is a description of the tools shown:

Icon

Name
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a)

Arterial
segmentation

(cine sequence only) Automatic spatio-temporal segmentation of the
large vessels, acquired using cine (2D+t) SSFP or PC sequence, relying on
our clinically validated algorithm.

Adjust contour

(cine sequence only) Semi-auto correction of the ROI’s contour using a
manual template.

Edit contour

(cine sequence only) Manual correction of the ROI’s contour using a
paintbrush-like tool.

Show velocity

(cine PC sequence only) Switch view to the associated phase image
displaying the velocities.

Background
correction

(cine PC sequence only) Set a background velocity noise ROI to correct
the velocities values.

Set aorta points

(3D sequence only) Manual setting of aorta centerline points.

Edit aorta points

(3D sequence only) Correction of the ROI’s path by moving already set
points.

Report

Open/close the report tab to review all the results of the current session.

Export CSV

Open the CSV export window to save the results locally on the computer
(files are located on the desktop, in an “ImageensReport” folder)

Arterial segmentation (cine sequence only) :

This tool is dedicated to the arterial section segmentation on cine sequence: Ascending aorta,
descending aorta or any pseudo-circular section.
1. Draw a rectangle around the arterial section by left click + drag onto viewer
2. An automatic circular initialization is proposed. Accept it if it is correct, or reject it to do a
manual initialization. To do so, click one point for the circle center, then one point for the circle
ridge.
3. The final segmentation is then automatically computed and displayed as an unlabeled ROI.

b)

Adjust contour (cine sequence only) :
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If the computed contour is faulty, it can be semi-automatically corrected.
1.
2.
3.
4.
5.
6.

c)

Select the desired ROI before assigning it a label
Click the Adjust Contour button
Identify the range of slices where the contour is faulty by selecting the first and the last images
Delineate the correct border of ROI on presented first slice and validate
Repeat for the presented last slice (only if different from first)
Automatic update of the contour is computed based on the manual template given in the two
previous steps.

Edit contour (cine sequence only):

If the computed contour is faulty, it can be manually corrected.
1. Select the desired ROI
2. Click the Edit Contour button
3. Maintain left click onto the viewer to display the paintbrush tool. The farther from the contour
the click, the larger will by the brush.
4. Move the contour by pushing it with the brush tool. To expand contour, click have to be inside
contour, to shrink it on the outside
5. If the ROI is labeled, clinical indices are automatically recomputed from corrected contour on
the left click release.

d)

Background velocity correction (cine PC sequence only):

This tool is used to rectify the velocities values by subtracting the background noise.
1. Click the Background Correction button
2. Design a circular area that represents a non-moving physical part and velocities are artifacts, by
two clicks, one for the circle center and one for the circle ridge. Velocity values are automatically
recomputed.

e)

Set aorta points (3D sequence only):

This tool is dedicated to the creation of an aortic centerline.
1. Pick points in the center of aorta lumen on each slice by a left click
2. Validate once finished
3. The final point set is displayed as an unlabeled ROI.

f)

Edit aorta points (3D sequence only):

If the centerline is faulty, it can be manually corrected.
1. Select the desired ROI
2. Click the Edit aorta points button
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3. Drag&drop relevant points to their new location
4. If the ROI is labeled, clinical indices are automatically recomputed from corrected path on the
left click release.

g)

Report

This button displays the reporting tab, a panel that resumes all the results of the current session. The
structure is as follow (exhaustive description of indices can be found in the 2.3 section):
●
●
●
●
●

h)

General patient and study information
Area measurements
Flow measurements (PC sequence only)
Transit Time measurement (PC sequence only)
Value of biomarkers (if previously calculated)

CSV Export

This tool allows the results of the session to be saved locally on the current computer. The button
displays a window where the user can indicate their estimation of the image quality, their confidence in
the measurements, and any useful comments. Click on the Export button in this window to save the
results. It generates 5 files located in the "ImageensReport" folder on the desktop:
●
●
●
●
●

ArtFunPlus_Records_VascularResults, containing all clinicals indicators from cine arterial ROIs
sorted by record date
ArtFunPlus_Records_Curves, containing all the curves values from cine arterial ROIs sorted by
record date
ArtFunPlus_Records_ROIs, containing all the coordinates of ROIs in image and patient space
from cine arterial ROIs, sorted by record date
Geometry_Records_LengthResults, containing the arterial length from 3D arterial ROIs sorted by
record date
Geometry_Records_ROIs, containing all the coordinates of ROIs in image and patient space from
3D arterial ROIs, sorted by record date.

All records are identified by date, but also by patient and image information:
●
●
●
●
●
●
●
●
●
●
●

Patient ID
Patient Name
Patient Age
Patient Weight
Study instance UID
Series instance UID
Series Description
Image Position Patient (image origin in patient space)
Image Orientation Patient (image orientation in patient space)
Image Size
Pixel Spacing
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●
●

ITK origin and scaled direction (A+ internal reference system)
Sequence Type

4.6 Results panel
Three sub-panels are provided:
Icon

Name

Description

ROI labels

Label up to 4 computed ROIs with a color and a name.

Arterial graphs
and indicators

Review the temporal curve of the arterial area during the cardiac cycle,
and blood velocity or flow (for PC acquisition), and the main clinical
indices automatically calculated on the curves.

Flow delay
estimation

(PC sequence only) Provide the transit time between 2 flow curves
(mainly between the ascending and descending aorta)

Aortic length & 3D
Review the created centerline as well as the computed aortic length.
view

a)

ROI labels

Up to 4 ROIs can be analyzed concurrently.
1. Select a ROI on the viewer.
2. Select a color disk to assign the color and automatically launch the analysis.
3. Select a name for the ROI among the proposed tags or write a custom one.
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b)

Arterial graphs and indicators

The top part of the panel displays the graph chart
1. Select the desired curve through the drop-down menu below the chart.
2. Select a color disk to hide/show a specific ROI.
3. Hover on the curves to get more information on values
The bottom part of the panel displays the computed clinical indices, concurrent ROIs being displayed by
column
1. Review the values by scrolling up/down
Note (PC sequence only): if a background correction has been made, it can be switched on/off in values
computation by selecting the icon (a) in the central part.

(a)
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c)

Flow delay estimation (PC sequence only)

The transit time between a pair of ROIs can be estimated from the flow curves
1. Select the desired pair by clicking on two color disks.
2. Transit time is estimated and displayed on the bottom of the graph.
3. Normalized curves can be displayed to get a better visualization of curve delay.
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d)

Aortic length & 3D view

The top part of the panel displays the 3D view that shows the created centerline over the anatomical
slices
1. Rotate the view with a left click
2. Zoom in/out with the mouse wheel or the right click
3. Change the focal point with Shift + left click
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The bottom part of the panel displays the computed aortic lengths, concurrent ROIs being displayed by
column

4.7 ArtFun+ Pop-Up
There are different types of pop-up windows in ArtFun+. Pop-ups can appear either for information or to
indicate that an action is required. These pop-ups are shown below.

a)

Informative pop-ups

All the pop-up windows shown below are for information purposes only. No action is required to
proceed, however, some pop-ups inform you of an error. It is necessary to take this information into
consideration in order to obtain a correct result at the end of the analysis. The steps to be taken to
resolve each error pop-up are listed in order of priority below each pop-up below.
1. Loading image in progress
2. Loading error
a. Check that the image sequence type is supported by ArtFun+. (Cine SSFP or Cine PC or
3D SSFP)
b. Check that the data are not corrupted or incomplete
c. Ensure that DICOMs are unzipped
d. If none of the above steps solves the error message you can contact IMAGEENS via the
contacts listed in part 7 of this manual.
3. Error in the automatic creation of the initial circle
a. This error message will automatically generate the action pop-up "How to perform a
segmentation correction manually".
4. Segmentation in progress
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5. Segmentation error
a. Check that the target object is an artery
b. Check that the image does not contain any errors
c. Re-trying segmentation
d. If none of the above steps solves the error message you can contact IMAGEENS via the
contacts listed in part 7 of this manual.
6. Region of interest analysis error
a. Ensure that the data is consistent and uncorrupted, e.g. for a PC sequence, check that
there is the same number for morphology and phase images)
b. If the above step does not solve the error message you can contact IMAGEENS via the
contacts listed in part 7 of this manual.
7. CSV export successful

b)

Action pop-ups

The pop-ups requiring an action are divided into two categories according to the type of action to be
performed. Some pop-ups will ask you to perform an action on the ArtFun+ plug-in window, others will
ask you to interact directly with the pop-up.
Pop-up involving an action on ArtFun+:
1.
2.
3.
4.
5.

How to make the bounding box for segmentation
How to make the initial circle manually
How to perform a segmentation correction manually
How to position the points for modeling the central aortic line
How to correct the points for modeling the central aortic line

Pop-up involving an action on the pop-up:
1. Request for automatic initial circle validation
2. Selection of the first frame for semi-automatic segmentation correction
3. Selection of the last frame for semi-automatic segmentation correction
Pop-ups 2 and 3 of this category ask you to select the first and last frame where you want to make a
segmentation correction. ArtFun+ will then automatically correct the segmentation of the aorta
between these frames.

5 Biomarker Calculation
5.1 Import series with Osirix or Horos
1. Import the cine (2D+t) PC or SSFP or 3D SSFP series that you want to examine to Osirix or Horos.
2. You can import DICOM files from CDs or other volumes or configure your local workstation as a
DICOM network node to receive data directly from your local PACS network.
3. Open the series that you want to examine with Osirix or Horos by selecting the patient in the list
and double click on the thumbnail. The series will appear in the Osirix/Horos 2D Viewer
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4. Open ArtFun+: launch the plugin ArtFun+ via the plugin menu item or via the toolbar shortcut

5.2 Arterial Function Analysis
This part of the manual defines the manipulations that can be performed according to the types of
images as well as the indices that can be drawn from the manipulations.

a)

Aortic length on 3D SSFP processing

Quantification:
1. Use the point tool to create a point set.
2. Assign a label to the newly created ROI through the Segmentation label panel.
3. The centerline is automatically extracted and displayed in the Aortic length & 3D view panel, as
well as the computed aortic length.

b)

Indices

Units

Descriptions

Aortic length

Millimeters (mm)

Total length of the centerline

Cine (2D +t) PC processing

Flow visualization and correction
You can display the velocities on the viewer through the Show velocity layer icon (a), and correct it with
the Background Correction tool (b). Switch back to morphology image with the Show magnitude layer
icon (c).

(b)
(a)

(c)

Quantification:
1. Use the segmentation tool to segment the arterial section.
2. Assign a label to the newly created ROI through the Segmentation label panel.
3. The area, flow and velocity curves are automatically extracted and displayed in the Arterial
graphs and indicators panel, as well as related indicators.
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4. If needed, compute transit time between two previously done ROIs by selecting both ROI colors
in the Flow delay estimation panel.
Indices

Units

Descriptions

Max Area

Square
Maximal area of segmented section during the
2
centimeters (cm ) cardiac cycle

Min Area

Square
Minimal area of segmented section during the cardiac
centimeters (cm2) cycle

Variation

Percent (%)

Ratio of max-min area over min area.
Also referred as Strain

Millimeters (mm)

Average diameter of the segmented section during
the cardiac cycle (computed from area with a circular
hypothesis)

Millimeters (mm)

Minimal diameter of the segmented section during
the cardiac cycle (computed from area with a circular
hypothesis)

Max Diameter

Millimeters (mm)

Maximal diameter of the segmented section during
the cardiac cycle (computed from area with a circular
hypothesis)

Diameter Variation

Percent (%)

Ratio of max-min diameter over min diameter

Beginning of ejection

Milliseconds (ms)

Time instant where the cardiac ejection begins

Ejection peak

Milliseconds (ms)

Time instant where the cardiac ejection flow peak
occurs

End of ejection

Milliseconds (ms)

Time instant where the cardiac ejection terminates

End of regurgitation

Milliseconds (ms)

Time instant where the cardiac flow regurgitation
terminates

Acceleration volume

Milliliters (mL)

Blood volume sent by the heart from the beginning of
ejection to the ejection peak

Mean Diameter

Min Diameter
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Ejection volume

Milliliters (mL)

Blood volume sent by the heart during the total
ejection phase

Regurgitation volume

Milliliters (mL)

Blood volume going backward due to regurgitation

Net volume

Milliliters (mL)

Blood volume flowing through during the whole
cardiac cycle

Regurgitation fraction

Percent (%)

Ratio of the regurgitation volume over the net
volume.

Flow at ejection peak

Milliliters per
seconds (mL/s)

Flow value recorded at the ejection peak

Ejection acceleration
slope

Ejection start
positive/negative

Ejection peak
positive/negative
Ejection end
positive/negative

Ejection volume
positive/negative
Net volume
positive/negative

Flow at ejection peak
positive/negative
Transit Time (Require 2
arterial section ROIs)
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Milliliters per
seconds per
milliseconds
(mL/s/ms)

First derivative (or slope) of the flow curve between
the ejection start and peak. Quantifies the
acceleration of flow.

Milliseconds (ms)

Time instant where the cardiac ejection begins
considering positive/negative flow only

Milliseconds (ms)

Time instant where the cardiac ejection
flow peak occurs considering positive/negative flow
only

Milliseconds (ms)

Time instant where the cardiac ejection ends
considering positive/negative flow only

Milliliters (mL)

Blood volume flowing through during the total
ejection phase considering positive/negative flow only

Milliliters (mL)

Blood volume flowing through during the whole
cardiac cycle considering positive/negative flow only

Milliliters per
seconds (mL/s)

Flow value recorded at the ejection peak for
positive/negative flow

Milliseconds (ms)

Time delay for the pulse wave to go from first arterial
section to second one
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c)

Cine (2D+t) SSFP

Quantification
1. Use the segmentation tool to segment arterial section.
2. Assign a label to the newly created ROI through the Segmentation label panel.
3. The area curve is automatically extracted and displayed in the Arterial graphs and indicators
panel, as well as related indicators.
Indices

Units

Descriptions

Max Area

Square centimeters
(cm2)

Maximal area of segmented section during the cardiac cycle

Min Area

Square centimeters
(cm2)

Minimal area of segmented section during the cardiac cycle

Variation

Percent (%)

Ratio of max-min area over min area. Also referred as Strain

Millimeters (mm)

Average diameter of the segmented section during the
cardiac cycle (computed from area with a circular
hypothesis)

Millimeters (mm)

Minimal diameter of the segmented section during the
cardiac cycle (computed from area with a circular
hypothesis)

Max
Diameter

Millimeters (mm)

Maximal diameter of the segmented section during the
cardiac cycle (computed from area with a circular
hypothesis)

Diameter
Var

Percent (%)

Ratio of max-min diameter over min diameter

Mean
Diameter

Min
Diameter

5.3 Stifness quantification
Changes in aortic stiffness have a high physiopathological relevance as they can lead to increases in the
aortic pulse pressure [2,3] and the cardiac pressure afterload, which can cause left ventricular
hypertrophy [4]. Arterial stiffness is recognized as a major risk factor in coronary heart disease [5,6], and
is considered as an independent predictor of cardiovascular mortality [7,8,9,10,11]. It is therefore
increasingly used in clinical practice [12]. Distensibility and pulse wave velocity (PWV) are commonly
used to characterize the arterial stiffness [13,14,15,16,17]. The distensibility describes the ability of the
artery to expand during systole, and is defined as the relative change in the cross-sectional area of the
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artery (strain) divided by the local pulse pressure. The PWV is the propagation speed of the pulse wave
along the artery, and is calculated as the ratio between the distance separating two locations and the
transit time needed for the wave to cover this distance.
Distensibility: local index for stiffness:
Combining the estimation of the deformability and the pulse pressure, a local index of distensibility in
the arterial section can be derived.
The distensibility is computed as:

The distensibility is automatically calculated and provided in the report if user makes the pulse pressures
available.
Pulse Wave Velocity: regional stiffness index
Combining the estimation of the transit time and the estimation of the length of the aortic arch, a
regional index of Pulse Wave Velocity in the aortic arch can be derived.
PWV is computed as:

6 ArtFun+ Shutdown
In order to close ArtFun, you must click on the cross at the top left of the user interface window.
Attention: make sure you save your work before closing the program. Any unsaved data will be lost
when you close the program.

7 Ask for support
You have troubles using the plugins? You have encountered a bug? Mail us at support@imageens.com
and we will help you troubleshoot your issues!

8 Explanation of label logos
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IMAGEENS, 23 Avenue d'Italie 75013 Paris

Manufacturing date

Name of the medical device

Reference of the medical device

UDI of the medical device

Version

Version of the medical device

Please consult the notice before using the Medical Device
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